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LRM Deployment Guide

Important
As of December 2016, new License Reporting Manager (LRM) 8.5 installations are no
longer permitted for any customer. Starting with Configuration Server 8.5.101.00
(released December 2016), LRM 8.5 can no longer be integrated with Configuration
Server. For more information, refer to the Technical Advisory.
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What is LRM?

License Reporting Manager (LRM) measures and stores usage data for licensed Genesys products and
user-defined bundles, providing Genesys users with license usage reports for compliance monitoring,
and Hosted Service Providers with usage data that can be used for billing end customers.

LRM is a server application that uses data from the Interaction Concentrator Database (IDB), GVP
Reporting Server, and Configuration Manager to execute data analysis and summarization. The LRM
Server should always be running, so it is available to respond to HTTP requests and generate reports
from the LRM Database (LRM DB).

Important
LRM does not support ADDP (Advanced Disconnect Detection Protocol).

LRM automatically retrieves configuration data for the various Genesys components at the 0, 10, 20,
30, 40, and 50 minute marks of every hour, which is used by LRM to calculate concurrent seat usage
during a nightly statistics job. You can schedule the nightly statistics job to run at the same time each
day when there is a low volume of interaction in the contact center (for example, at night).

During this nightly statistics job, LRM performs the following tasks:

• Reads the configuration data for the various Genesys components to calculate the concurrent peak
usage for certain sellable items.

• Generates concurrent peak usage data for various sellable items from ICON:
• Reads the login session data from all the ICON instances connected to the LRM and temporarily

stores the results in the LRM DB.
• Calculates all sellable items in minute intervals at the tenant level.
• Calculates and stores the daily value for all sellable items at the tenant and system levels.
• Calculates and stores the daily value for all user-defined bundles at the tenant and system levels.

See Predefined and User-Defined Bundles for details.
Note: For LRM to retrieve data from ICON, the ICON DB must be running and available, although
ICON itself is not required.

• Generates concurrent peak usage data for some sellable items for GVP, for the GVP Reporting Server,
and GVP-related sellable item:
• Creates HTTP requests for each of these sellable items, all the tenants, and the system.
• Stores the data in the LRM DB.

• Generates enabled seat count data for sellable items from Configuration Server:
• Takes a snapshot of the Places and DN objects in configuration.
• Stores the data in the LRM DB.
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• Generates Agent Groups and Place Groups usage data if the configuration options are set to enable this
functionality.

LRM also accepts HTTP requests for reports and generates HTTP responses containing these reports.
The LRM Plug-in for GAX uses this HTTP service to generate reports.

You can also use other services to generate their own reports by using the LRM web services API.

LRM Architecture

The following is a diagram of the LRM architecture diagram. Any functionality not shown in the
diagram is designed to support ease of installation.
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LRM Components
[+] License Reporting Manager
The License Reporting Manager (LRM) server is a standalone server that performs the following
functions:

• Reads the license file imported into Genesys Configuration Server, extracts the entitlement information
from the license file, and stores the entitlement information to be used by the LRM.

• Executes a nightly statistics job to gather statistics for sellable item data from ICON, GVP and
Configuration Server at the scheduled time.

• Sends alarm messages in case of failures during the nightly statistics job.
• Ensures no two LRM instances can run nightly statistics jobs at the same time.
• Generates JSON reports over HTTP requests, in response to requests sent from the LRM Plug-in for GAX.
• Confirms the availability of the following and generates a message after thirty minutes of failure:

• JDBC connection to all configured ICON databases
• JDBC connection to the LRM database
• Write access to the JOURNAL table of the LRM database
• Read access to object on Configuration Server

[+] LRM Database
The LRM Database stores summarized data calculated by LRM.

[+] LRM Plug-in for GAX
The LRM Plug-in for Genesys Administrator Extension (GAX) provides a GAX User Interface to perform
the following tasks:

• Upload a Bundles XML file.
• Generate a License Usage Report.
• Provide Agent and Place group reporting.
• Modify the Provisional Count for tenants.

Associated Components
[+] Genesys Administrator Extension (GAX)

• Installs and configures ICON and LRM using a wizard for ease of installation
• Displays on-demand reports to the user, by retrieving data from the LRM via the HTTP Web Services API.
• Provides custom screens to allow provisioning of tenant usage limits
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• Provides custom screens to upload files representing bundle definitions.

[+] Management Framework
Use Management Framework to obtain entitlement information from the license file provided by
Genesys Management Framework. See the Entitlement Information tab on this page for details.

Important
To successfully install and use Management Framework 8.5.x, you must install and
have LRM 8.5.x running. For Management Framework 8.1.x or earlier, you must use
LRM 8.1.x.

[+] Configuration Server
Use Configuration Server to perform the following tasks:

• Configure the customer's environment.
• Configure the LRM application.
• Store data (for example, entitlement data and user-defined bundles).

Loading Configuration Objects from Configuration Server

LRM reads the license file stored on Configuration Server, extracts the entitlement sellable item
information from the license file, and stores the entitlement information to be used by the LRM. See
the Genesys Licensing Guide available on the Genesys System-Level Guides page for additional
details about license files.

To calculate certain sellable items, LRM loads some configuration information into the database,
including the following configuration objects:

• Switch—For the calculation of all sellable items
• Person, Agent Group, Place Groups—For the calculation of the Outbound Contact - MS seats sellable

item.
• Person’s Skills (as a part of Person)—For the calculation of the Skill Based Routing seats sellable item.

LRM looks for specific conditions and loads information into the LRM database about the tenants to
whom these conditions apply before it starts data preprocessing. The following conditions are
examined in order to determine eligibility of a sellable item:

• URS with a single tenant and DAP connection for CTI seats sellable item.
• WFM Data Aggregator application with connection to Stat Server for the Workforce Management Seat

sellable item.
• All SIP Server and T-Server applications to determine if they are configured as an HA pair, for the High
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Availability Sellable Item.
• Info Mart applications for the Genesys Info Mart Server and Genesys Interactive Insights Sellable Items.

[+] Interaction Concentrator and the Interaction Concentrator database
ICON collects run-time information from Genesys Servers and stores the information in the Interaction
Concentrator database (IDB). LRM retrieves data from the IDB to perform calculations for the various
sellable items. ICON does not have to be running for LRM to retrieve data from the IDB. LRM supports
ICON servers in high availability without counting duplicate records which exist in more than one
ICON server.

The table below lists the database tables from which LRM extracts data to generate reports, and the
purpose of the extracted data.

IDB Tables and Data Extracted by LRM

Table name Purpose of extracted data

G_LOGIN_SESSION For login sessions

G_AGENT_STATE_RC To determine the usage of Genesys Agent Desktop
or Genesys Supervisor Desktop

G_DSS_GOS_PROVIDER To determine the data gap
G_DSS_GLS_PROVIDER To determine the data gap
GO_CAMPAIGN To determine the usage of Outbound sellable items

GX_SESSION_ENDPOINT To determine the usage of Web and E-mail sellable
items

[+] GVP Reporting Server
LRM collects HTTP reports from GVP Reporting Server to obtain concurrent peaks for GVP-related
sellable items. GVP Reporting Server performs the concurrent peak calculations that are required by
LRM. LRM collects and stores these results in the LRM DB. LRM supports the high availability setup of
GVP Reporting Server, which is set up with HTTP basic authentication.

Important
• Historical reporting must be enabled on the GVP Reporting Server for LRM and GVP to

work together. To enable historical reporting on GVP Reporting Server, do not run GVP
Reporting Server in nodb mode; that is, set the [persistence] rs.nodb.enabled option
to false (the default value).

• GVP Reporting Server must be running for LRM to collect data.

[+] Genesys Servers

What is LRM?
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Genesys Servers are the servers running Genesys software, which perform the functions required by
the customer. LRM measures the usage of these servers. Examples of these servers are T-Server, SIP-
Server, Interaction Server, and GVP Media Control Platform.

[+] Genesys Administrator
LRM uses Genesys Administrator (GA) to perform general Genesys OA&M functionality, such as:

• Manual starting LRM
• Monitoring and display of alarms generated from LRM

[+] Message Server
Message Server receives log output from the LRM Report Generator.

High Availability - LRM

LRM Report Generator operates in conjunction with any high-availability database implementation
that is supported by DB Server, such as Oracle Real Application Clusters.

To implement high-availability in LRM, use one pair of identically configured LRM instances. Each LRM
instance must have its own LRM application object in the Management Framework, where one LRM
instance is configured as a Backup Server of the other. Both LRM instances share the same LRM
Database and you can use the same DAP object to access the LRM Database. Each LRM instance can
be in either Primary or Backup mode, which is determined by the Management Framework Solution
Control Server.

When operating in Primary mode, the LRM server gathers data from ICON, GVP and Configuration
Server and stores the result in the LRM database as a nightly statistics job. The LRM server also
responds to HTTP requests from the LRM Plug-in for GAX to generate reports. When operating in
Backup mode, no nightly statistics job runs, even when the scheduled time is reached, and the LRM
server closes the HTTP socket, which means it does not respond to any incoming report requests from
the LRM Plug-in for GAX.

The nightly statistics job has a locking mechanism, so that in the unlikely event that more than one
LRM Server tries to invoke the nightly statistics job, only one of these jobs can occur at one time.

LRM supports ICON servers in a high availability configuration without counting duplicate records
which exist in more than one ICON server. LRM also supports the primary/backup setup of the GVP
Reporting Server, and GVP Reporting Server set up with HTTP basic authentication.

Entitlement Information

The entitlement information for your system describes how many seats of each sellable item it is
entitled to use. LRM measures the usage of your system for each sellable item comparing it to the
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entitled amount.

LRM obtains entitlement information from the license file provided by Genesys Management
Framework. The system operator must import the license file to their Configuration Server database
using their provided tools. See Management Framework documentation on how to do this. The import
process writes the license file content to one of the options of the Configuration Server object.

An existing license file is valid when it meets the following conditions:

• The file generated date is in the past.
• The string genesys.d is in each technical license feature line.
• The expiration date of at least one technical license line is in the future.

LRM checks for updates in the imported license file on the Configuration Server every 10 minutes.
When LRM detects an updated license file, it imports the content of the license file into the LRM
entitlement data on configuration server for use in future entitlement calculations. LRM imports the
data from each entitlement record into a single transaction object. The transaction object is named
lrm-entitlement-<id> where the <id> is calculated from the license text.

If there is a problem while parsing the license file, an error is logged in the LRM log file, the license is
not imported, and LRM uses previous entitlement information. License file problems can include
format errors, or no valid sellable items recognized by LRM.

License File Example
[+] License file example

In this example, LRM verifies the license file by checking the technical lines for genesys.d, valid
future dates, and the file generated date. LRM selects “CIM Platform – MS” as the product license and
the quantity 100 as the entitlement reference data for use in LRM reports.

SERVER hostname 0123456789AB
DAEMON genesys.d/license_path
FEATURE 3GP08394ADAA genesys.d 8.0 1-dec-2000 100 0123456789AB \

vendor_info= " v8.0 SIP Server" \
NOTICE="Customer (Reseller) license_use" SIGN=0123456789AB

FEATURE 3GP08394ADAA genesys.d 8.0 1-dec-2000 100 0123456789AB \
vendor_info= " v8.0  CIM Platform - MS" \
NOTICE="Customer (Reseller) license_use" SIGN=0123456789AB

FEATURE tserver_sdn genesys.d 8.0 1-dec-2000 15000 EED4CB263FBA \
NOTICE="Customer (Reseller) license_use" SIGN=0123456789AB

FEATURE tserver_tdn genesys.d 8.0 1-jan-2020 999999 A38192807F61 \
NOTICE="Customer (Reseller) license_use" SIGN=0123456789AB

FEATURE tserver_iscc genesys.d 8.0 1-jan-2020 999999 84AF27E990C7 \
NOTICE="Customer (Reseller) license_use" SIGN=0123456789AB

FEATURE cti_ha_option genesys.d 8.0 1-jan-2020 999999 2DF38A08C725 \
NOTICE="Customer (Reseller) license_use" SIGN=0123456789AB

#
#  Order : 11111111
#  Site# : 1111
#  IPN : "Customer (Reseller) license_use "
#  Requestor: "Mary Lee"
#  Generated: 2004-12-17 09:51:19c

[+] License file description
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Important
To create entitlement data for License Reporting Manager (LRM) release 8.1.2 or
earlier, see Creating the Entitlement File in the License Reporting Manager 8.1.2
Deployment Guide.

Concurrent-Seat Calculations

License Reporting Manager uses the concurrent-seat measurement to indicate concurrent peak usage
and time of the concurrent peak usage (rounded to the previous one-minute boundary). LRM
determines peak concurrent-seat usage by calculating the actual number of seats instantaneously in
use at one minute intervals.

A seat is a physical chair whose occupant is logged in to T-Server, Interaction Server, or SIP Server
and provides data on Place and DN details. A login session includes login from a:

• DN that is associated with a Place.
• DN that is not associated with a Place.
• Place that is not associated with a DN.

LRM assumes that each login session has a unique ID. Seat usage is based on a Place; when a Place
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is not available in the login session, seat usage is based on a DN.

The table below shows how the seat usage is determined by the Place and DN data in the login
session.

Seat Calculations

Place name DN name Seat for which this login session is
counted

Place 1 DN1DN2DN3 Seat 1
DN4 Seat 2

Place 1 Seat 1

• For login sessions from DNs associated with Place1—DN1, DN2 or DN3—These are considered single
seat usage. During calculation, LRM uses seat usage based on a Place.

• For login sessions from DNs not associated with a Place (separate seat per DN), LRM uses seat usage
based on a DN.

• For login sessions from a Place. For example, for an Interaction Server login session, LRM uses seat
usage based on a Place calculation type.

You can configure LRM to calculate the number of concurrent seats. To calculate concurrent seats,
LRM records the peak number of logged-in seats for each 24 hour interval, and the time of the
concurrent peak usage.

LRM calculates concurrent seats by performing the following:

1. Selects the available login sessions by using the following criteria:
• Time frame—LRM selects login sessions from the G_LOGIN_SESSION table of the Interaction

Concentrator database that have at least a one second overlap with a given time interval. The login
sessions that were started or terminated exactly at the edges of the given time interval are not
counted. For example, to receive login sessions for 08/08/10, the following criteria is used:
• Start time < 08/09/10 00:00:00 and termination time (or sessions not yet terminated) > 08/08/

10 00:00:00
• All sessions in which termination time = 08/08/10 00:00:00 and start time = 08/09/10 00:00:00

are excluded.
Note: Sessions that are not terminated, but started nine hours before the reporting day, are
treated as stuck sessions and are not counted for concurrent-seat usage.

• Place and DN filter combination—LRM selects login sessions based on seat calculations.

• Applies the particular sellable item criteria.
• Calculates and stores the number of active login sessions in the LRM database.

2. Applies the particular sellable item criteria.
3. Calculates and stores the number of active login sessions in the LRM database.

Concurrent Peak Use Calculation
A data snapshot of concurrent peak use is used to calculate concurrent-seat measurements.

What is LRM?
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Concurrent peak use is determined as the actual peak during the 24-hour period, using a
continuously updated record of seats in use according to the license definitions. The data snapshot of
concurrent peak use is an instantaneous snapshot taken at one-minute intervals.

The concurrent peak use calculation includes a method of filtering or minimizing the weight of
concurrent-seat peak values, possibly on predefined time intervals. For example, during Agent shift
change overlaps. This filtering mechanism is enabled by configuring the lrm-excluded-time option.
For more information about how to configure this option, see Configuration Options.

To calculate concurrent seats peak usage data for a given period, the date and hour of concurrent
peak usage during that period is also recorded.

Concurrent-Seat Processing
This section describes how concurrent seats are calculated based on sellable items.

Agent Connector

License Reporting Manager measures and generates usage reports for Agent Connector. An Agent
Connector seat is a physical seat occupied by a person who is not using a Genesys Agent Desktop,
Genesys Supervisor Desktop, or Interaction Workspace for the log-in.

Use is measured from the time the person logs in until the time the person logs out. If the seat has an
associated place, usage is based on the place. If the seat does not have a place, usage is based on
the person's voice session.

Call Qualification Parking

License Reporting Manager measures and generates usage reports for simultaneous sessions using
Genesys Media Server providing the following services:

• Video on hold
• DTMF digit collection
• Prompts and Announcements
• Audio streaming on hold

License Reporting Manager determines the number of simultaneous Media Server ports in use
providing one of the above services and the associated time stamps that have a resolution of one
minute or less. The calculation indicates the maximum number of Media Server ports simultaneously
in use within a given reporting interval, and the date and time the maximum use occurred. If the
maximum number of simultaneous resources used of a given type occurs on more than one occasion,
LRM reports the date and time of the latest occasion on which the maximum count was reached.

Important
LRM stores only DAY, WEEK, and MONTH for this sellable item.
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Chat Media Type for Interaction Server

A Genesys Web Media seat is a physical seat that is occupied by a person who is configured as an
Agent, logged into Interaction Server, and associated with a media channel of type chat.

Use of a Genesys Web Media seat is measured from the time the Agent logs in until the time the
Agent logs out. If an Agent logs in to Interactions Server using other media, but the Agent added chat
media later during a login session, the entire duration of the login session are counted as consuming
a Genesys Web Media seat license. Use is based on the Place from which the Agent logs in.

The calculation of Genesys Web Media Concurrent seats includes the use of a Genesys Web Media
seat. The calculation provides the maximum number of Genesys Web Media seats simultaneously in
use within a given reporting interval, and the date and time the maximum use occurred.

Computer Telephony Integration Contact-Center Legacy

A Computer Telephony Integration (CTI) seat refers to a physical seat that is occupied by an Agent
who is logged in to a T-Server, SIP Server or Interaction Server in a tenant for which at least one
tenant-specific instance (in other words, has only this tenant in the tenant list) of Universal Routing
Server (URS) is configured with a connection to a database access point (DAP).

LRM provides a report of a CTI seat that is based on the presence of a DAP connection and applies to
all of the logged in seats in a given tenant. The report does not depend on whether database queries
were actually performed in the process of routing calls to a given seat.

Use is measured from the time the person logs in until the time the person logs out. If the DN from
which the Agent logs in has an associated Place configured in Configuration Database, use is based
on the Place. If the DN does not have a Place configured in Configuration Database, use is based on
the DN from which the Agent logs in. A login is counted as using a license even if the Agent who logs
in is not configured in Configuration Database.

If a URS with a DAP connection is associated with multiple tenants, LRM does not report any usage of
CTI seat licenses associated with that URS instance.

If a tenant has multiple URS instances with DAP connections, LRM reports one CTI seat license per
logged-in seat.

The calculation of CTI Concurrent seats includes any use of a CTI seat that indicates the maximum
number of CTI seats simultaneously in use within a given reporting interval, and the date and time
the maximum use occurred.

E-Mail Media Type for Interaction Server

A Genesys E-Mail seat is a physical seat that is occupied by a person who is configured as an Agent,
logged in to Interaction Server, and associated with a media channel of type email.

Use of a Genesys E-Mail seat is measured from the time the Agent logs in until the time the Agent
logs out. If an Agent logs in to an e-mail media channel at any time during a login session, the entire
duration of the login session are counted as consuming a Genesys E-Mail seat license. Use is based
on the Place from which the Agent logs in.

The calculation of Genesys E-Mail Concurrent seats includes any use of a Genesys E-Mail seat that
indicates the maximum number of Genesys E-Mail seats simultaneously in use within a given
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reporting interval, and the date and time the maximum use occurred.

Genesys Agent Desktop and Genesys Supervisor Desktop

License Reporting Manager measures and generates usage reports for Genesys Agent Desktop and
Genesys Supervisor Desktop.

A Genesys Agent Desktop seat is a physical seat that is occupied by a person who is configured as an
Agent and logged in to a T-Server, SIP Server or Interaction Server through Genesys Agent Desktop. A
Genesys Supervisor Desktop seat is a physical seat that is occupied by a person who is configured as
a Supervisor and logged in to a T-Server, SIP Server or Interaction Server through Genesys Supervisor
Desktop.

Genesys Agent Desktop and Genesys Supervisor Desktop sellable items are associated with a Place.
If a login session from a particular Place has a special Reason Code, this Place is calculated as a
Genesys Desktop item.

If two different Genesys applications login to the same Place (in other words, one application initiates
an Open Media session and the other application initiates a voice session), the two applications are
calculated as one Genesys Desktop sellable item because both applications are logged into and are
using the same Place.

Genesys CIM Platform - Single-Site and Multi-Site

A CIM Platform has two kinds of seats: Single-Site (SS) seat and Multi-Site (MS) Concurrent seat. Each
is a physical seat occupied by a person who is logged in to a T-Server, SIP Server, or Interaction
Server in a location that is defined as SS for Single-Site or MS for Multi-Site in the Genesys
Entitlement File. Use is measured from the time the person logs in until the time the person logs out.
If the DN from which the Agent logs in has an associated Place configured in Configuration Database,
use is based on the Place. If the DN does not have a Place configured in Configuration Database, use
is based on the DN from which the Agent logs in.

For the CIM Platform - MS or SS Concurrent seats, LRM provides a report that shows the maximum
number seats (MS or SS) simultaneously in use within a given reporting interval, and the date and
time the maximum use occurred.

LRM determines if the site is defined as Single-Site or Multi-Site by examining data in the entitlement
tables (which contain(s) the data from the Entitlement File). When the site has been defined as SS or
MS, all of the login sessions from the preselected set are calculated as a Genesys CIM Platform - SS or
MS sellable items.

Genesys Inbound Voice

A Genesys Inbound Voice seat is a physical seat whose occupant is logged in to any T-Server other
than SIP Server. Use of a Genesys Inbound Voice seat is measured from the time the Agent logs in
until the time the Agent logs out. If the DN from which the Agent logs in has an associated Place
configured in Configuration Database, use is based on the Place. If the DN does not have a Place
configured in Configuration Database, use is based on the DN from which the Agent logs in. A login is
counted as using a license even if the Agent who logs in is not configured in Configuration Database.

The calculation of Genesys Inbound Voice concurrent seats includes any use of a Genesys Inbound
Voice seat that indicates the maximum number of Genesys Inbound Voice seats simultaneously in
use within a given reporting interval, and the date and time the maximum use occurred.
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Because SIP Server and T-Server have the same application type in Configuration Database, to
distinguish between the two different server types LRM uses the switch type information where the
login occurred.

Genesys Info Mart

A Genesys Info Mart seat is a physical seat occupied by a person who is configured as an Agent and
logged in to a Genesys deployment where at least one instance of the Genesys Info Mart application
is configured. Use is measured from the time the person logs in until the time the person logs out. If
the seat has an associated place, usage is based on the place. If the seat does not have a place,
usage is based on the person’s voice session.

Genesys Interaction Workspace

A Genesys Interaction Workspace seat is a physical seat that is occupied by a person who is
configured as an Agent and logged in to a T-Server, SIP Server or Interaction Server through
Interaction Workspace. Use is measured from the time the person logs in until the time the person
logs out. If the seat has an associated place, usage is based on the place. If the seat does not have a
place, usage is based on the person’s voice session.

Genesys Interactive Insights

A Genesys Info Mart seat is a physical seat that is occupied by a person who is configured as an
Agent and logged in, in a Genesys deployment where at least one instance of the Genesys Info Mart
application is configured and Interactive Insights is defined in the Entitlement File.

Use is measured from the time the person logs in until the time the person logs out. If the seat has an
associated place, usage is based on the place. If the seat does not have a place, usage is based on
the person’s voice session.

Genesys Network Voice

A Genesys Network Voice seat is a physical seat occupied by an Agent who is configured as an Agent
and is logged in to a T-Server other than SIP Server, on a system that has one or more (non-SIP)
Network T-Servers configured. Use of a Genesys Network Voice seat is measured from the time the
Agent logs in until the time the Agent logs out. If the DN from which the Agent logs in has an
associated Place configured in Configuration Database, use is based on the Place. If the DN does not
have a Place configured in Configuration Database, use is based on the DN from which the Agent logs
in.

Limitation

There is no reliable way to determine a Network Switch or a Network T-Server. However, it is possible
to configure the Network Switch as a Voice switch in Configuration Database. You can also enable
LRM to count Genesys Network Voice sellable items by setting the LRM lrm-network-switch option to
true. Refer to the License Reporting Manager 8.1 Deployment Guide for more information about how
to configure this option.

Genesys Outbound Contact - Multi-Site

A Genesys Outbound Contact - Multi-Site (MS) seat is a physical seat a person logs into a Genesys T-
Server, where at least one of the following conditions is true:
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• The person who logs in is an Agent who is a member of an Agent Group that is associated with at least
one Outbound Contact Service Campaign Group that was loaded during this login session.

• The Place the login occurs is a member of a Place Group that is associated with at least one Outbound
Contact Service Campaign Group that was loaded during this login session.

And a site type that is defined as MS (Multi-Site) in the Genesys Entitlement File.

Use of a Genesys Outbound Contact - MS seat is measured from the time the person logs in until the
time the person logs out, regardless of when the Campaign Group was loaded or unloaded.

Important
If the DN from which the person logs in has an associated Place configured in
Configuration Database, use is based on the Place. If the DN does not have a Place
configured in Configuration Database, LRM does not report usage of an Outbound
Contact - MS seat license, because OCS does not deliver calls to that DN.

The calculation of Genesys Outbound Contact - MS Concurrent seats includes any use of a Genesys
Outbound Contact - MS seat that shows the maximum number of Genesys Outbound Contact - MS
seats simultaneously in use within a given reporting interval, and the date and time the maximum
use occurred.

Genesys SIP Server

A SIP Server seat is a physical seat whose occupant is logged in to SIP Server. Use of a SIP Server
seat is measured from the time the Agent logs in until the time the Agent logs out. If the DN from
which the Agent logs in has an associated Place configured in Configuration Database, use is based
on the Place. If the DN does not have a Place configured in Configuration Database, use is based on
the DN from which the Agent logs in. A login is counted as using a license even if the Agent who logs
in is not configured in Configuration Database.

The calculation of SIP Server Concurrent seats includes any use of a SIP Server seat that indicates the
maximum number of SIP Server seats simultaneously in use within a given reporting interval, and the
date and time the maximum use occurred.

Genesys Social Media

A Genesys Social Media seat is a physical seat occupied by a person who is configured as an Agent
logged in to Interaction Server and associated with a media channel of type other than email, chat, or
voice and the sub-type of the login is facebook, twitter, or rss.

Use is measured from the time the person logs in until the time the person logs out. If an agent logs
into a media channel other than email, chat, or voice with a subtype of facebook, twitter, or rss at
any time during a login session, the entire duration of the login session is counted as consuming a
Genesys Social Media seat license.

The Genesys Social Media seat usage is based on the place the agent logs in. One Genesys Social
Media seat license is required for each Genesys Social Media in each place, regardless of the number
of media types supported by each system.
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The calculation of Genesys Social Media seats includes any use of a Genesys Social Media seat
indicates the maximum number of Genesys Social Media seats simultaneously in use within a given
reporting interval, and the date and time the maximum use occurred.

Genesys Workforce Management

A Workforce Management seat is a physical seat that is occupied by a person who is logged in to a T-
Server, SIP Server, or Interaction Server where WFM Data Aggregator is configured with a connection
to a Stat Server that is associated with the person’s tenant. When these conditions are met, LRM
treats all logins within the tenant as utilizing a Workforce Management seat license, regardless of the
identity of the person who is logging in. Use is measured from the time the person logs in until the
time the person logs out.

If the seat has an associated Place configured in Configuration Database, usage count is based on the
Place. If the seat does not have a Place configured in Configuration Database, usage count is based
on the DN on which the person is logged in.

LRM provides a report of Workforce Management Concurrent seats that indicates the maximum
number of persons simultaneously logged into T-Server, SIP Server, or Interaction Server in a tenant
that has Genesys Workforce Management configured.

GVP Ports

License Reporting Manager measures and generates usage reports for simultaneous sessions using
Genesys Voice Platform. License Reporting Manager determines the number of simultaneous GVP
ports in use providing VoiceXML services and the associated time stamps that have a resolution of
one minute or less.

The calculation indicates the maximum number of GVP ports simultaneously in use within a given
reporting interval, and the date and time the maximum use occurred. If the maximum number of
simultaneous resources used of a given type occurs on more than one occasion, LRM reports the date
and time of the latest occasion on which the maximum count was reached.

Important
LRM stores only DAY, WEEK, and MONTH for this sellable item.

GVP TTS and ASR Ports

License Reporting Manager measures and generates usage reports for simultaneous sessions using
GVP text-to-speech (TTS) and automatic speech recognition (ASR) resources.

Use is measured from the time the resource is included in the call flow until the time the resource is
released from the call flow. License Reporting Manager determines the number of simultaneous GVP
resources of each type in use and the associated time stamps that have a resolution of one minute or
less.

The calculation of resources includes any use of a GVP resource that indicates the maximum number
of GVP resources simultaneously in use within a given reporting interval, and the date and time the
maximum use occurred. If the maximum number of simultaneous resources used of a given type
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occurs on more than one occasion, LRM reports the date and time of the latest occasion on which the
maximum count was reached.

Important
LRM stores only DAY, WEEK, and MONTH for this sellable item.

High Availability

A High Availability seat is a physical seat that is occupied by a person who is configured as an Agent
and logged in to a T-Server or SIP Server configured in high availability mode.

Use is measured from the time the person logs in until the time the person logs out. If the seat has an
associated place, usage is based on the place. If the seat does not have a place, usage is based on
the person’s voice session.

QM Call Recording

License Reporting Manager measures and generates usage reports for simultaneous sessions using
QM Call Recording, by measuring the number of simultaneous sessions using Genesys Media Server
providing the Recording service.

License Reporting Manager determines the number of simultaneous Media Server ports in use
providing the above services and the associated time stamps that have a resolution of one minute or
less.

The calculation indicates the maximum number of Media Server ports simultaneously in use within a
given reporting interval, and the date and time the maximum use occurred. If the maximum number
of simultaneous resources used of a given type occurs on more than one occasion, LRM reports the
date and time of the latest occasion on which the maximum count was reached.

Important
LRM stores only DAY, WEEK, and MONTH for this sellable item.

Skills-Based Routing

A Skills Based Routing seat refers to a physical seat that is occupied by a person who is logged in to a
T-Server, SIP Server or Interaction Server and has at least one Skill configured.

LRM provides a report of a Skills-Based Routing seat based on the configuration of the Skills of the
Agent who is logged in. The report does not take into account whether the skills were actually
considered in the process of routing calls to a given seat.

Use is measured from the time the person logs in until the time the person logs out. If the DN from
which the Agent logs in has an associated Place configured in Configuration Database, use is based
on the Place. If the DN does not have a Place configured in Configuration Database, use is based on
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the DN from which the Agent logs in.

The calculation of Skills-Based Routing Concurrent seats includes any use of a Skills-Based Routing
seat that indicates the maximum number of Skills-Based Routing seats simultaneously in use within a
given reporting interval, and the date and time the maximum use occurred.

Tenant-License Usage

License Reporting Manager measures and generates usage reports for purchased quantities and
actual usage quantities of tenant licenses.

During creation of a daily or monthly usage report in its database, LRM includes the purchased
license quantity that was in effect for the interval that is being reported, as follows:

• If a single purchased license quantity was in effect for the entire duration of the report interval, LRM
reports that value as the purchased license quantity.

• If more than one purchased license quantity was in effect during the report interval, LRM reports the
value that was in effect at the end of the report interval.

• If the purchased license quantity in effect at the time of report creation is different from the value that
was in effect at the time of the interval being reported, LRM uses the value that was in effect for the
interval being reported.

LRM does not regenerate existing usage reports stored in its database when purchased license
quantities are changed.

Third-Party Work Items

A third-party work items seat is a physical seat that is occupied by a person, who is configured as an
Agent logged in to Interaction Server, and associated with a media channel of type other than email,
chat, or voice.

Use is measured from the time the person logs in until the time the person logs out. If an agent logs
into a media channel other than email, chat, or voice at any time during a login session, the entire
duration of the login session is counted as consuming a third-party work item seat license.

The third-party work item seat usage is based on the place from which the agent logs in. One third-
party work item seat license is required for each third-party system in each place, regardless of the
number of media types supported by each system.

The calculation of third-party work item seats includes any use of a third-party work item seat that
indicates the maximum number of third-party work item seats simultaneously in use within a given
reporting interval, and the date and time the maximum use occurred.

Enabled-Seat Calculations

LRM calculates the number of enabled seats by looking at the DN and Places configurations in the
Configuration Server. For the purpose of counting enabled seats, a seat is defined as either of the
following objects configured in the Configuration Server:

• Place associated with at least one DN.
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• DN not associated with a Place.

License Reporting Manager can count the number of enabled seats by counting the objects
configured in the Configuration Server. LRM counts sellable items differently, depending on the
sellable item criteria.

Enabled-Seat Processing
Agent Connector

The enabled seat count for Agent Connector is measured differently than the other enabled seat
counts mentioned here. The daily enabled seat count for Agent Connector is defined as the total
number of unique seats (i.e. Places and DNs) that has been used during the day that are not using a
Genesys Agent Desktop, Genesys Supervisor Desktop, or Interaction Workspace for the log-in.

Chat Media Type for Interaction Server

Assume any seats configured in the system may be used to log into the Interaction Server and then
once logged in, they can use any of the media channel they want. In this case, the enabled seat
count is the total of the number of Places associated with at least one DN, plus the number of DNs
not associated with a Place.

Computer Telephony Integration Contact-Center Legacy

A Computer Telephony Integration (CTI) seat refers to a physical seat occupied by an Agent who
might use it to log in to a T-Server, SIP Server or Interaction Server in a tenant for which at least one
tenant-specific instance (in other words, has only this tenant in the tenant list) of Universal Routing
Server (URS) is configured with a connection to a database access point (DAP). If a URS with a DAP
connection is associated with multiple tenants, LRM does not report any usage of CTI seat licenses
associated with that URS instance.

If a tenant has multiple URS instances with DAP connections, LRM counts one CTI seat license per
enabled seat. LRM provides a report of enabled CTI seat count based on the presence of a DAP
connection and applies to all of the logged in seats in a given tenant. The enabled seat count is the
total of the number of Places associated with at least one DN, plus the number of DNs not associated
with a Place, where the DNs belong to a switch that belong to a tenant that meet the above URS
configuration condition.

E-Mail Media Type for Interaction Server

Assume any seats configured in the system may be used to log into the Interaction Server and then
once logged in, they can use any of the media channel they want. In this case, the enabled seat
count is the total of the number of Places associated with at least one DN, plus the number of DNs
not associated with a Place.

Genesys CIM Platform - Single-Site and Multi-Site

A CIM Platform has two kinds of seats: Single-Site (SS) seat and Multi-Site (MS) Concurrent seat. Each
is a physical seat occupied by a person who might log in to a T-Server, SIP Server, or Interaction
Server in a location defined as SS for Single-Site or MS for Multi-Site in the Entitlement File. LRM
determines if the site is defined as Single-Site or Multi-Site by examining data in the entitlement
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tables, which contain the data from the Entitlement File. When the site has been defined as SS or MS,
all of the login sessions from the preselected set are calculated as a Genesys CIM Platform- SS or MS
sellable items. For the CIM Platform - MS or SS Concurrent seats, LRM counts the number of enabled
seats as the total of the number of Places associated with at least one DN, plus the number of DNs
not associated with a Place.

Genesys Inbound Voice

A Genesys Inbound Voice seat is a physical seat whose occupant might use it to log in to any T-Server
other than SIP Server. A seat is enabled for use if the DN associated with this seat is on this kind of
Switch. For Genesys Inbound Voice, the enabled seat count for the system is the total of the number
of Places associated with at least one DN, plus the number of DNs not associated with any Place,
where the DNs belong to a switch that is not configured as 0 (Unknown Switch), 72 (SIP Switch) or 63
(OM Switch).

Genesys Network Voice

A Genesys Network Voice seat is a physical seat whose occupant is configured as an Agent and might
log in to a T-Server other than SIP Server, on a system that has one or more (non-SIP) Network T-
Servers configured. A seat is enabled for use if the DN associated with this seat is on this kind of
switch and the LRM has determined that one or more (non-SIP) Network T-Servers is configured. In
this case, the enabled seat count for Genesys Network Voice for the system is the total of the number
of Places associated with at least one DN, plus the number of DNs not associated with a Place, where
the DNs belong to a switch that is not configured as 72 (SIP Switch) or 63 (OM Switch).

Limitation

There is no reliable way to determine a Network Switch or a Network T-Server. However, it is possible
to configure the Network Switch as a Voice switch in Configuration Database. You can also enable
LRM to count Genesys Network Voice sellable items by setting the lrm-network-switch option in the
[lrm] section to true. For more information about how to configure this option, see Configuration
Options.

Genesys SIP Server

A SIP Server seat is a physical seat whose occupant might use it to log in to SIP Server. A seat is
enabled for SIP Server use if the DN associated with this seat is on a SIP Server Switch. For Genesys
SIP Server, the enabled seat count for the system is the total of the number of Places associated with
at least one DN, plus the number of DNs not associated with any Place, where the DNs belong to a
switch that is configured as 72 (SIP Switch).

Genesys Social Media

Assume any seats configured in the system may be used to log into the Interaction Server and then
once logged in, they can use any of the media channel they want. In this case, the enabled seat
count is the total of the number of Places associated with at least one DN, plus the number of DNs
not associated with a Place.

Genesys Workforce Management

A Workforce Management seat is a physical seat occupied by a person who might log in to a T-Server,
SIP Server, or Interaction Server where WFM Data Aggregator is configured with a connection to a
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Stat Server associated with the person's tenant. When these conditions are met, the LRM considers
the seats enabled for this tenant to be enabled for Workforce Management. The enabled seat count is
the total of: the number of Places associated with at least one DN, plus the number of DNs not
associated with a Place, where the DNs belong to a switch that belongs to a tenant that has
Workforce Management enabled.

Genesys Outbound Contact - Multi-Site

The License Reporting Manager assumes that any seats configured in a Multi-Site environment is
enabled for outbound contacts. LRM determines from the entitlement data whether the location is SS
or MS. If the location is multi-site, LRM counts the number of enabled seats as the total of the number
of Places associated with at least one DN, plus the number of DNs not associated with a Place.

Skills-Based Routing

The License Reporting Manager assumes that any seats configured in the customer environment may
be logged in by an agent with skills configured. LRM counts the number of enabled seats as the total
of the number of Places associated with at least one DN, plus the number of DNs not associated with
a Place.

Third-Party Work Items

Assume any seats configured in the system may be used to log into the Interaction Server and then
once logged in, they can use any of the media channel they want. In this case, the enabled seat
count is the total of the number of Places associated with at least one DN, plus the number of DNs
not associated with a Place.

Genesys Agent Desktop

This sellable item is based on the client software used to log in. The LRM assumes that any seats
configured in the system may be used to log into the T-Server, SIP Server or Interaction Server. In this
case, the enabled seat count is the total of the number of Places associated with at least one DN,
plus the number of DNs not associated with a Place.

Genesys Supervisor Desktop

This sellable item is based on the client software used to log in. The LRM assumes that any seats
configured in the system may be used to log into the T-Server, SIP Server or Interaction Server. In this
case, the enabled seat count is the total of the number of Places associated with at least one DN,
plus the number of DNs not associated with a Place.

Genesys Info Mart Server

In a deployment where at least one instance of the Genesys Info Mart application has been
configured, the enabled seat count for Genesys Info Mart Server is the total of the number of Places
associated with at least one DN, plus the number of DNs not associated with a Place.

Genesys Interactive Insights

In a deployment where at least one instance of the Genesys Info Mart application has been
configured and Interactive Insights has been defined in the Entitlement File, the enabled seat count
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for Genesys Info Mart Server is the total of the number of Places associated with at least one DN, plus
the number of DNs not associated with a Place.

Interaction Workspace

This sellable item is based on the client software used to log in. The LRM assumes that any seats
configured in the system may be used to log into the T-Server, SIP Server or Interaction Server. In this
case, the enabled seat count is the total of the number of Places associated with at least one DN,
plus the number of DNs not associated with a Place.

IVR Connector

An enabled IVR Connector port is an IVR Port object on the Configuration Server where the IVR Port
option is set to enabled. The LRM counts the total number of these objects for the number of enabled
IVR Connector ports.

High-Availability

A T-Server, or SIP-Server may be configured as High-Availability if you set up a Backup Server for it. A
seat is enabled for High-Availability if it can be used to log into such a T-Server. In this case, the
enabled seat count for High-Availability is the total of the number of Places associated with at least
one DN, plus the number of DNs not associated with a Place, where the DNs belong to a switch where
its associated T-Server has been configured as Highly-Available.

Voicemail

A voicemail count is a DN object on the Configuration Server where the DN object has the [Tserver]
gvm_mailbox option set to any value. The LRM counts the number of these DN objects as the number
of enabled mailboxes.

Agent Groups and Place Groups Calculations

LRM provides the following reporting of Agent groups and Place groups usage:

• Date/Time
• Agent Group
• Number of agents configured in an agent group (enabled agents)
• Concurrent Seat usage by agents in an agent group

The data collected enables trending reports over time:

• Groups Detailed Seat Usage
• Groups Daily Seat Usage
• Groups Weekly Seat Usage
• Groups Monthly Seat Usage
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LRM provides group details by sellable item. This requires that for agent group reports, reporting by
individual sellable items (from a menu) may be selected, as with other usage reports.

The agentgroup_enabled configuration option enables agent group reporting and the
placegroup_enabled configuration option enables place group reporting. Both are disabled by
default. These options must be enabled for LRM to retrieve group data during the nightly statistics job
and perform the usage calculation. See Configuration Options for details.

Bundles are not supported for agent groups or place groups.

Enabled Seat Count
LRM stores the enabled seat count for each sellable item at 10-minute intervals for each configured
agent group and place group. LRM calculates the enabled seat count in the group by counting the
number of agents or places configured for the group and stores the result in a temporary table.

Concurrent Seat Count
During the LRM nightly statistics job, LRM retrieves data from ICON to calculate and store the
concurrent seat usage for each Agent Group and Place Group. The per-minute concurrent seat usage
is created and stored for each day for the sellable item for each group.

When calculating the concurrent seat count, LRM uses the latest collected place and agent group
membership information at the time of calculation for the report day.

For example, if the LRM server is running without interruption and you calculate the concurrent seat
count, the group membership information from the end of day is used for the calculation. If the group
membership configuration changes between the time the agent logs in and the concurrent seat
calculation time (end of the day), LRM may not calculate an accurate place and agent group
concurrent seat usage based on the group membership configuration at the time of the agent login.

Supported Sellable Items
LRM supports the following set of sellable items for Agent groups and Place groups:

• genesys_inbound_voice
• sip_server
• genesys_outbound_contact_ms
• genesys_email
• genesys_web_media
• third_party_work_items
• genesys_cim_platform_ss
• genesys_cim_platform_ms
• genesys_network_voice
• cti
• genesys_workforce_management
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• skills_based_routing
• genesys_agent_desktop
• genesys_supervisor_desktop
• genesys_interaction_workspace
• high_availability
• genesys_info_mart_server
• genesys_interactive_insights
• genesys_social_engagement

Logging Events

To permit the manual verification of License Reporting Manager operations, LRM generates log
messages that report all significant events.

These significant events include the following:

• Event for Normal Operation:
• Data collection from Interaction Concentrator (start and end times)
• Data output into LRM Report Database (start and end times)
• License Report File created
• Genesys Entitlement data imported
• Overuse alert generated
• Gap detected

• Event for Error Conditions:
• Data-source connection failure
• Data-source data errors
• Entitlement data errors
• LRM internal processing errors
• LRM database connection failure
• LRM database corruption
• LRM application outage and recovery

To view actual log events for License Reporting Manager, see the Framework 8.1 Combined Log
Events Help, which provides detailed information about log events that are associated with LRM.
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Product License Coverage
Genesys has over 100 product licenses, not all of which can be measured and tracked by LRM. LRM
focuses primarily on the most common licenses that are used in production systems. Laboratory and
demonstration system licenses are not tracked.

The Product License Coverage table lists the licenses that are measured and tracked in License
Reporting Manager.

Product License Coverage

Product category Product Releases Measurement Condition/Limitation

Base platform Genesys CIM
Platform-MS 7.6+ Concurrent and

Enabled Seats

Base platform Genesys CIM
Platform-SS 7.6+ Concurrent and

Enabled Seats

Base platform HA-CIM 7.6+ Concurrent and
Enabled Seats

Desktops and
Gplus Adapters

Computer-
telephony
integration (CTI)

7.6+ Concurrent and
Enabled Seats

Restricted to
existing customers

Desktops and
Gplus Adapters

Genesys Agent
Desktop 7.6.3+ Concurrent and

Enabled Seats

Desktops and
Gplus Adapters

Genesys
Supervisor
Desktop

7.6.3+ Concurrent and
Enabled Seats

Desktops and
Gplus Adapters

Interaction
Workspace 8.1+ Concurrent and

Enabled Seats

Multi-channel Genesys E-Mail 7.6+ Concurrent and
Enabled Seats

Multi-Channel Genesys Social
Media 7.6+ Concurrent and

Enabled Seats

Multi-channel Genesys Web
Media 7.6+ Concurrent and

Enabled Seats

Multi-channel SIP Voicemail 8.1 Concurrent and
Enabled Seats

Multi-channel Third-party work
items 7.6+ Concurrent and

Enabled Seats

Outbound Contact Genesys Outbound
Contact - MS 7.6+ Concurrent and

Enabled Seats

Reporting Genesys Info Mart 7.6+ Concurrent and
Enabled Seats

Reporting
Genesys
Interactive Insights
(GI2)

7.6+ Concurrent and
Enabled Seats
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Product category Product Releases Measurement Condition/Limitation

Routing Agent Connector 7.6+ Concurrent and
Enabled Seats

Routing Genesys Inbound
Voice 7.6+ Concurrent and

Enabled Seats

Routing Genesys Network
Voice 7.6+ Concurrent and

Enabled Seats

Routing IVR Connector 7.6+ Concurrent and
Enabled Seats

Routing SIP Server 7.6+ Concurrent and
Enabled Seats

Routing Skills Based
Routing 7.6+ Concurrent and

Enabled Seats
Restricted to
existing customers

Voice Portal Call Qualification
Parking 8.1.6+ Concurrent ports

Voice Portal GVP ASR Ports 8.1.6+ Concurrent ports
Voice Portal GVP TTS Ports 8.1.6+ Concurrent ports
Voice Portal GVP Ports 8.1.6+ Concurrent ports
Workforce
Management

Genesys Workforce
Management 7.6+ Concurrent and

Enabled Seats
Workforce
Management

QM - Call
Recording 8.1+ Concurrent and

Enabled Seats
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Deploying LRM
<multistep> |-| LRM Deployment Overview= Use this overview of the deployment to serve as a
License Reporting Manager (LRM) deployment quick reference. Select a link for more information or
click Next Step to view details of each step. The browser back button is not supported on this page.

1. Install initial Management Framework components.
2. Confirm platform support.
3. Confirm installation requirements.
4. Install GAX.
5. Install the LRM Plug-in for GAX and add the LRM application to the Connections list for GAX.
6. Import the LRM application template.
7. Create a LRM DB and add a DAP.
8. Create and configure the LRM application.
9. Install LRM.

10. Set the timezone to GMT on the LRM server and the GVP Reporting Server.
11. Schedule the statistics gathering job.
12. Plan data backup.
13. Configure LRM High Availability (Optional).
14. Enable Secure Connection Features (Optional).
15. Complete Management Framework Installation.
16. Configure Interaction Concentrator (ICON) and Interaction Workspace options.
17. Install ICON.
18. Add a DAP object for each ICON DB.
19. Create a cron job to clean up old ICON data.
20. Configure GVP Reporting Server for LRM.
21. Start LRM.

|-| Install initial Management Framework components= Before you install LRM 8.5.x, you must install
a portion of Management Framework 8.5.x components. However, until LRM is installed,
Configuration Server interacts only with Management Framework. When you start LRM for the first
time after installation, it connects to Configuration Server, and this enables Configuration Server
functionality.

Important
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In a distributed environment, LRM works only with the master Configuration Server,
not Configuration Server Proxy.

See the Management Framework installation.

|-| Confirm platform support=

The Platforms Supported by LRM table lists the operating systems, databases, and virtualization that
are supported by LRM in this release.

Platforms Supported by LRM

Platform category Platform Versions

OS IBM AIX • 7.1 (64-bit)

OS Microsoft Windows
• 2012 64-bit
• 2008 64-bit

OS Red Hat Linux
• 5.0 (32-bit)
• 5.0 (64-bit)
• 6.0 (64-bit)

OS Solaris • 10

Database IBM DB2 • 9.7

Database Microsoft SQL Server
• 2008
• 2012

Database Oracle

• 11g
• 11g RAC
• 12c
• 12c RAC

Database PostgreSQL • 9.0
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Platform category Platform Versions

Virtualization VMware • 5.0, 5.1

|-| Confirm installation requirements=

Confirm hardware sizing and performance information in the Genesys Hardware Sizing Guide.

Confirm you are using:

• Management Framework 8.5 or later
• Customer Interaction Management 8.5 or later
• Genesys Interaction Concentrator 8.1.x
• Genesys Voice Platform Reporting Server 8.1.5 or later
• Sun Java Runtime Environment (JRE) 7.0 or later

Tip
Before you install LRM 8.5.x, you must install a portion of Management Framework
8.5.x components including Configuration Server. However, until LRM is installed,
Configuration Server interacts only with Management Framework. When you start LRM
for the first time after installation, it connects to Configuration Server, and this
enables Configuration Server functionality. See the Management Framework
installation.
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LRM Architecture

Any additional functionality not shown in the above diagram is designed to support ease of
installation.

|-| Install GAX= Genesys recommends you install GAX release 8.1.4 or later. See the GAX Deployment
Guide available on the Genesys Administrator page.

|-| Install LRM Plug-in for GAX= The LRM Plug-in for GAX is an add-on component that is hosted by an
existing Genesys Administrator Extension (GAX) installation. The LRM Plug-in for GAX accesses data
from the LRM database to provide on-demand reporting to Service Providers and tenant
administrators in the GAX graphical user interface (GUI) application .

1. Install the LRM plug-in files into the existing GAX directories to enable report generation of LRM
statistics from GAX. See Installing a GAX compatible plug-in for details.

2. In Configuration Manager, add the LRM Application object on the Connection tab of the GAX object.
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Notes:

• To use the plug-in, open GAX and select License Reporting from the reports menu.
• Refer to GAX online help for:

• Report Generation – System Reports, Tenant reports, Agent and Place Group reports
• Provisioning
• Bundle upload
• Viewing Entitlements

|-| Import the LRM application template= To import the required application templates before you
configure License Reporting Manager to work in your Genesys environment. Configuration Manager
or Genesys Administrator can be used for this and all other procedures that are related to
configuration.

1. Open the Environment folder and select the Application Templates folder.
2. From the File menu, select Import Application Template.
3. In the Open window that appears, import the following template from your CD:

• templates/License_Reporting_Manager_850.apd.

4. Click Open. The Properties window opens.
5. Click OK. The template is imported into the Application Templates folder.

|-| Create a LRM DB and add a DAP=

1. Create your LRM database.
2. Configure the DAP object on the General tab as a JDBC connection with the correct database server

credentials for the DAP object.
3. Set the role configuration option in the [lrm] section to main.

Exactly one of your DAPs must have the role value set to main for the LRM DAP. At least one of your
DAPs must have the role value set to icon.

Tip
You do not need to run any SQL scripts create empty tables for LRM. LRM creates the
tables automatically when the nightly job runs for the first time.

|-| Create and configure the LRM application=

1. Open the Environment folder and select the Applications folder.
2. From the File menu, select New > Application. The Browse window opens, listing all application

templates that are present in the Configuration Database.
3. Choose the License Reporting Manager application template.
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4. Click OK. The Properties window appears.
5. On the General tab, add a unique name to the Name field for this instance of LRM.
6. Select the Server Info tab. In the Host Name field, add the name of the host on which you are installing

the application.
7. Select the Start Info tab, and add “...” to each of the following fields:

• Working Directory
• Command Line

These fields are automatically filled with the correct information when LRM is installed.

8. Select the Connections tab. Right-click and select New. In the Server field, enter the name of each DAP.
Add:
• A DAP for the LRM database. Set the value of role to main in the DAP Application.

9. Select the Security Tab. Under Log On As, select This Account. Click Open file to display a list of
names and select a user with full control permissions over the Environment tenant. This enables LRM to
write the entitlement information into the Transactions of the Environment tenant when it imports the
license file.

10. Click OK. Configuration of your LRM instance is complete.

|-| Install LRM=

[+] Install LRM on Linux
To locate and launch the License Reporting Manager installation wizard to manually install LRM on
Linux.

1. Confirm your target computer meets the platform and component prerequisites that are listed in the
Genesys Supported Operating Environment Reference Guide.

2. Confirm you have installation rights.
3. Locate the compressed installation files, Read_Me file, and templates on the installation DVD.
4. In a terminal window, open and run the install.sh file in the License Reporting Manager directory on the

installation DVD.
5. When prompted, enter the Host Name or press Enter for “Local Host”.
6. When you are prompted to do so, enter the Configuration Server Name, Network port number, User

name, and Password.
7. From the displayed list, choose an application that you want to install. When you are prompted to do so,

enter the number of your chosen application.
8. Enter the location in which you want your application to be installed. Provide the full path.

A list of files that have been installed in your application’s destination location is displayed, along with
a message that informs you of your successful installation.

9. Verify you have installed License Reporting Manager successfully by inspecting the destination directory
of your application for completeness.
• Browse to the destination location of your LRM application.
• Inspect the directory and confirm it contains the following folders:
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• libs/
• templates/

• Inspect the directory and confirm it contains the following files:
• lrm_startup.sh
• lrmserver.jar

Important
If the system has more than 50,000 agents, LRM requires additional Java Heap space to load the agent
information from the Configuration Server. Edit the lrm_startup.sh file so that LRM_OPTS has the following
Java parameter:

# Non-standard parameters
LRM_OPTS=-Xms2048m

Tip
To uninstall LRM, remove all of the files from the folder in which LRM is installed.

[+] Install LRM on Windows
To manually install LRM using the Genesys installation wizard provided on the LRM product DVD.

1. On the License Reporting Manager 8.1 product DVD, open the lrm\Windows\ directory.
2. Locate and double-click setup.exe to start the Genesys Installation Wizard.
3. On the Welcome page, click the About button to review the read_me file for this installation package.

The file also contains a link to the Release Notes file for LRM.
4. Click Next to proceed with the installation.

Note: Click Next at the end of each step to proceed to the next page.
5. On the Connection Parameters to the Genesys Configuration Server page, specify the following login

parameters:
• Host and port of Configuration Server
• User name and password used to log in to the Configuration Layer.

6. Select the application you want to install.
7. The Choose Destination Location page displays the destination directory, as specified in the Working

Directory property of the LRM Application object. If the path is configured as Working Directory is
invalid, the wizard generates the following path to the destination directory:

C:\Program Files\GCTI\LRM\<LRM Application Name>\

If necessary, click one of the following:

• Browse—To select another destination folder. The wizard updates the Application object’s Working
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Directory property in the Configuration Database.
• Default—To reinstate the path specified in the Application object’s Working Directory property.

8. On the Ready to Install information page, click one of the following:
• Back—To update any installation information.
• Install—To proceed with installation. The Installation Status window appears, showing the installation

progress.

9. On the Installation Complete page, click Finish.
As a result of the installation, the wizard adds Interaction Concentrator icons to the following:

• Windows Start menu, under Programs > Genesys Solutions.
• Windows Add or Remove Programs dialog box, as a Genesys server.
• Windows Services list, as a Genesys service with the Automatic startup type.

10. Verify you have installed License Reporting Manager successfully by inspecting the destination directory
of your application for completeness.

11. Browse to the destination location of your LRM application.
• Inspect the directory to confirm that it contains the following folders:

• libs\
• templates\

• Inspect the directory to confirm that it contains the following files:
• JavaServerStarter.ini
• lrmserver.jar
• lrmservice.exe
• startServer.bat

Important
If the system has more than 50,000 agents, LRM requires additional Java Heap space to load the agent
information from the Configuration Server. In the LRM installation directory, add the following line to the
JavaServerStarter.ini file under [JavaArgs]:

-Xms2048m

Tip
To uninstall LRM, remove all of the files from the folder in which LRM is installed.

|-| Set the timezone to GMT= You must configure LRM server and GVP Reporting Server to use the
GMT timezone, because LRM uses the GMT time zone to keep track of the days in the system.
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|-| Schedule the statistics gathering job= Schedule the nightly statistics gathering job to run at the
time each day when there is a low volume of interactions in the contact center (for example, at
night).

Set the schedule option in the [lrm] section to an appropriate value for your contact center. The
default value is 01:00 (1am GMT).

|-| Plan data backup= It is important to regularly backup the data in your License Reporting Manager
database to prevent data loss. Backup of the LRM database is the responsibility of the Database
Administrator. The following LRM tables can be backed up using the tools in your particular RDBMS:

LRM_CONCURRENT_SEAT
LRM_ENABLED_SEAT
LRM_CONCURRENT_GROUP_USAGE
LRM_ENABLED_GROUP_DETAILS
LRM_ENABLED_GROUP_SUMMARY
LRM_JOURNAL

|-| Configure LRM High Availability (Optional)=

You can set up LRM as a pair of primary-backup applications. Both applications must be installed,
configured, and started. If both of these applications are up and running, the Solution Control Server
determines which of the applications act as the Primary, while the other acts as the backup.

To configure the system, the system administrator must:

1. Install and configure two separate instances of LRM.
2. Select the Server Info tab in the Application object for the primary LRM application.
3. Click the open folder icon next to the Backup Server field to choose the LRM application which is to

serve as the backup.

|-| Enable Secure Connection Features (Optional)=

You can secure connections from LRM to Configuration Server. All of the security
features are optional.
1. Enable Transport Layer Security (TLS) protocol.

a. UNIX only: Install the Genesys Security Pack on the LRM server host, and set the applicable
environment variable to specify the path to the Security Pack libraries. See "Security Pack
Installation" in the Genesys 8.1 Security Deployment Guide.

b. Create and install certificates on the LRM server host and Configuration Server host. See
"Certificate Generation and Installation" in the Genesys 8.1 Security Deployment Guide.

c. If required, change the configurations of the Configuration Server applications:
• Add a new port for secure connections. On the Configuration Server Application object, select

the Auto Detect mode.
• Use a host certificate.

See "Genesys TLS Configuration" in the Genesys 8.1 Security Deployment Guide.

d. On the LRM Application object, add connections to Configuration Server. When you add the
connection(s), you must use the port that you created in the previous step.
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5. Enable client-side port definition.
a. When you install LRM, select the connection parameters that LRM will use for the initial connection

to Configuration Server. See "Client-Side Port Definition" in the Genesys 8.1 Security Deployment
Guide.

b. In the LRM Application object, add or modify the connection to Configuration Server, to specify
the connection parameters (port number and, optionally, IP address) that LRM uses to reconnect to
Configuration Server after a switchover or disconnection. Configure the parameters in the
Transport Protocol Parameters text box on the Advanced tab of the connection properties. See
"Client-Side Port Definition" in the Genesys 8.1 Security Deployment Guide.

3. Enable the SSL protocol on the JDBC connections between LRM and its source and target databases.
When you configure the extraction DAP(s) and the LRM DAP, use the jdbc-url option to specify the
URL information as required by your RDBMS to implement JDBC over SSL.

|-| Complete Management Framework Installation=

1. Start LRM.
2. Complete the Management Framework installation.

|-| Configure ICON and Interaction Workspace options= In order for LRM to calculate statistics it is
important that certain Interaction Concentrator and Interaction Workspace options be set correctly.

callconcentrator Section

1. [role]—This option specifies the type of data that the Interaction Concentrator instance processes and
stores in the Interaction Concentrator database.

For Interaction Concentrator release 8.1 and later, the ICON instance can be configured to store your
LRM-specific data. You must set the role option to lrm. Do not combine the lrm role with any other in
the same instance of ICON.

See the Interaction Concentrator 8.1 Deployment Guide for more information about using ICON for
License Reporting Data.

2. [use-dss-monitor]—This option must be used with LRM for the usage data gap processing. Set this
option to 1 to populate the G_DSS_GLS_PROVIDER and G_DSS_GOS_PROVIDER tables with Interaction
Concentrator release 8.0.000.25 or later.

See the Interaction Concentrator 8.1 Deployment Guide for more information on the use-dss-monitor
option.

3. [dss-no-data-tout]— This option must be used with LRM for the usage data gap processing. Set this
option to the preferred value. This option enables you to set the time interval after which Interaction
Concentrator provides the NoData indication in the G_DSS_GLS_PROVIDER and G_DSS_GOS_PROVIDER
tables. The NoData indication enables you to distinguish cases in which there was no data from those in
which a connection problem prevented the data from being properly recorded.

See the Interaction Concentrator 8.1 Deployment Guide for the default and valid values for the dss-no-
data-tout option.

filter-data Section
Make sure that the gls data options are set to their default values (equal to 0).
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• [gls-all]
• [gls-ivr]
• [gls-no-person]
• [gls-queue]

See the Interaction Concentrator 8.1 Deployment Guide for the full description of the filter-data
options.

interaction-workspace Section

• [license.lrm-enabled]—This option must be added and set to true to enable Interaction Workspace to
support LRM. This feature might not work if Interaction Workspace is customized. Changes take effect
after you restart Interaction Workspace.

|-| Install ICON= Install ICON and create a database for ICON if necessary. See the ICON Deployment
Guide on the Interaction Concentrator page

Important
You can reuse ICON from other parts of your deployment.

|-| Add a DAP object for ICON=

To configure the LRM solution properly, you must define Database Access Point (DAP)objects that
describe the databases to which LRM has access. Create a DAP object for each ICON to which you
connect, and you cannot reuse the corresponding DAP object already in use by ICON, because LRM
uses the JDBC options to configure the connection to the databases. The LRM application extracts
data from these ICON databases used to prepare the reporting data.

1. Configure the DAP object on the General tab as a JDBC connection with the correct database server
credentials for the DAP object.

2. Set the role configuration option in the [lrm] section to icon.

Important
Exactly one of your DAPs must have the role value set to main for the LRM DAP. At
least one of your DAPs must have the role value set to icon.

|-| Create a cron job to clean up old ICON data=

Create a cron job to clean up old ICON data by using the DB purge script. See the ICON User's Guide
on the Interaction Concentrator page for details.

|-| Configure GVP Reporting Server for LRM=
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Important
• Historical reporting must be enabled on the GVP Reporting Server for LRM and GVP to

work together. To enable historical reporting on GVP Reporting Server, do not run GVP
Reporting Server in nodb mode; that is, set the [persistence] rs.nodb.enabled option
to false (the default value).

• GVP Reporting Server must be running for LRM to collect data.

1. Select the Connections tab. Right-click and select New. In the Server field, enter the name of the GVP
Reporting Server. If your GVP Reporting Server is set up as an HA pair, add only the primary instance
and not the backup.

|-| Start LRM=

When the installation of License Reporting Manager (LRM) has been verified, and the LRM databases
have been initialized, start LRM in Genesys Administrator.

1. In Genesys Administrator, select Operations > Applications > <LRM Application>.
2. Right click on the LRM application name and select Start applications.

|-| </multistep>
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Create a Custom Billing Adapter
The License Reporting Manager (LRM) plug-in for GAX provides a report interface to display license
usage information that is collected by LRM. However, you might want to use your own custom
reporting solution to display licensing information that is collected by the LRM Server.

You can use the Web Services API that is exposed by the LRM Server to obtain the information that is
collected by LRM.

GET data from LRM

GET data from LRM

When the LRM Application is running, it can accept HTTP GET requests and return an LRM report.

The URL that is exposed by the LRM server has the following format:

http://<server>:<port>/lrm/seats?name1=value1&name2=value2...

Where <server> is where the LRM application is running and <port> is the socket that is being
opened by the LRM application to listen for HTTP requests. All the request parameters that control
which records are returned in an LRM report can be presented as HTTP Request URI parameters (for
example, name1=value1 in the URL above). The following HTTP Request-URI parameters are
supported:

Name Description Valid Values

type

Specifies the type of report.

If type is system, then
tenant, agentgroup,
and placegroup are
ignored. If type is one of
tenant, agentgroup, or
placegroup, then
unmatched parameters
within the set are
ignored.

This parameter is
required.

• system

• tenant

• agentgroup

• placegroup
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Name Description Valid Values

start

Specifies the starting timestamp.

This parameter is
required.

Specifies the timestamp in the
format of:
yyyy-mm-ddThh:mm:ss.mmmZ

For example:
2010-09-01T00:00:00.000Z

end

Specifies the ending timestamp.

This parameter is
required.

Timestamp in the format of:
yyyy-mm-ddThh:mm:ss.mmmZ

For example:
2010-09-01T00:00:00.000Z

granularity

Specifies the granularity for each
record; that is the duration
represented by each record:
10minute, hour, day, week, or
month.

This parameter is
required.

• 10minute

• hour

• day

• weekly

• month

firstDayOfWeek

Specifies how a week is is
calculated for reports where
granularity=week.

This parameter is
required if
granularity=week.

• sunday

• monday

pageSize

Specifies the maximum number
of records in a single page of a
report. Reports are paginated
based on the pageSize
parameter, and the page that is
returned in a report is specified
by using the pageNumber
parameter.

This parameter is
required.

integer

pageNumber Works with pageSize to control
which records are returned. integer
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Name Description Valid Values

This parameter is
required.

tenant

Specifies which tenant’s license
usage data are in the report. If
this value is not specified and the
type parameter is set to tenant,
then data for all the tenants is
returned.

comma-separated list of tenant
IDs

sellableitem Specifies which sellable items are
in the report.

comma-separated list of sellable
item IDs

agentgroup Specifies which agent groups are
in the report.

comma-separated list of agent
group IDs.

placegroup Specifies which place groups are
in the report.

comma-separated list of place
group IDs

bundle Specifies which bundles are in
the report.

comma-separated list of bundle
IDs

At least, one sellable item or bundle can be specified. If neither a sellable item nor a bundle is specified,
then data for all the sellable items and bundles is returned.

LRM reports

LRM reports

The report is returned in the HTTP response body in JSON format (see RFC 4627). The report is a
single JSON object that has the following properties:

Name Description
total The total number of records in the report.

start

The start timestamp of the report. Note that the
start and end timestamps might be different from
the parameter that is specified by the HTTP
Request URI parameter in the case of weekly or
monthly reports, so that the start and end
timestamps line up with the week and month
boundaries.

end The end timestamp of the report.
pageNumber The page number from the set of records.
tenants The set of tenants known in the LRM system.

records An array of records that contains the data for this
report. The logical meaning for each entry of the
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Name Description
array is described above.

Note: Within each record of the records array:

• If the request type is tenant, then only tenantid and tenantname attributes are included in the report.
• If the request type is agentgroup then only agentgroupid and agentgroupname attributes are included

in the report.
• If the request type is placegroup then only placegroupid and placegroupname attributes are included

in the report.
• If the request type is system then none of these attributes are included in the report.

Data Description

This section describes the logical meaning of the data that is presented by LRM.

A unit of record in the LRM data contains information about the usage of a single sellable item at a
single unit of time. Each record contains the following information:

Name Description

report_period The starting time of the License Usage information
for this record.

sellableitemid
The Sellable Item ID of the Sellable Item for which
this record applies. If the sellableitemid is 10000
or greater, then this is a record for a bundle.

sellableitemname The name of the sellable item for this record.

tenantid
The Genesys Management Framework DBID for the
tenant that this record is for. If this is a record for
system-wide data, then the tenantid is set to 0.

tenantname
The name of the tenant. If this is a record for
system-wide data, then the tenantname is set to
the value null.

agentgroupid The Genesys Management Framework DBID for the
agent group for this record.

agentgroupname The name of the agent group.

placegroupid The Genesys Management Framework DBID for the
place group for this record.

placegroupname The name of the tenant.

si_amount Records the concurrent peak usage for this time
period, for this sellable item, for this tenant.

timestamp The timestamp at which the concurrent peak usage
has occurred.

enabled_seat_count Contains the enabled seat count that is calculated
for this time period, for this sellable item, for this
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Name Description
tenant.

provlimit

The provision limit, as configured by customer,
applicable to the day in which the record occurred.
For system-wide reports, this comes from the
Entitlement File that is uploaded by the System
Administrator. For tenant reports, this comes from
the Provisioned Count screen as entered by the
System Administrator. This not available for
agentgroup and placegroup reports.

provdatetimestamp
The day when the provision limit first came into
effect. This not available for agentgroup and
placegroup reports.

gap
Indicates whether a data source gap (from the T-
Server and Interaction Server to the ICON) has
been detected while calculating the concurrent
peak usage

An LRM report contains a sequence of these records that are retrieved from the LRM Server based on
some query criteria that is provided by the request.

Examples

HTTP Request Example

An example of an HTTP request is as follows:

http://135.17.176.48:8801/lrm/
seats?type=tenant☆t=2008-05-07T00:00:00.000Z&end=2012-05-17T00:00:00.000Z&granularity=day&pageSize=1000&pageNumber=1&tenant-
id=1&sellableitem=1

Report Example

An example of the report is as follows:

{
"total": 14,
"end": "2012-05-17T00:00:00.000Z",
"start": "2008-05-07T00:00:00.000Z",
"pageNumber": 1,
"tenants": {

"550": "Tenant_sg04_03_INBD",
"1": "Environment",
"551": "Tenant_sg04_04_OTBD",
"548": "547"

}
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"records": [{
"timestamp": "2009-01-01T14:56:51.000Z",
"tenantid": 1,
"tenantname": "Environment",
"agentgroupid": 12,
"agentgroupname": "kathyteam"
"placegroupid": 24,
"placegroupname": "newplace"
"report_period": 200901010000,
"si_amount": 1,
"gap": false,
"enabled_seat_count": 3,
"provdatetimestamp": "2009-01-01T00:00:00.000Z",
"sellableitemid": 1,
"provlimit": 100,
"sellableitemname": "Genesys Inbound Voice",

}, {
"timestamp": "2009-01-02T14:56:51.000Z",
"tenantid": 1,
"tenantname": "Environment",
"agentgroupid": 12,
"agentgroupname": "kathyteam"
"placegroupid": 24,
"placegroupname": "newplace"
"report_period": 200901020000,
"si_amount": 2,
"gap": false,
"enabled_seat_count": 3,
"provdatetimestamp": "2009-01-01T00:00:00.000Z",
"sellableitemid": 1,
"provlimit": 100,
"sellableitemname": "Genesys Inbound Voice",

}],
}
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Use Predefined and User-Defined Bundles

What are Bundles?

Predefined Bundles

A predefined bundle is a group of standard Genesys-sellable items that are configured and named for
you for resale as a single feature to your customer. The predefined bundle appears as a single item in
the license-usage measurement data that is accessed for billing and other tenant reports in License
Reporting Manager (LRM).

User-Defined Bundles

A user-defined bundle is a group of standard Genesys-sellable items that you configure and name for
resale as a single feature to your customers. The user-defined bundle appears as a single item in the
license usage measurement data that is accessed for billing and other tenant reports. You have the
option of creating the bundle definition file manually and importing it into LRM. Each of the user-
defined bundles has an ID, name, description, and definition in terms of included and excluded
sellable items.

Bundle Set

A bundle set is a set of related bundles that are managed as a group. Each bundle set has an ID,
name, description, issue date (the date that the set was created), valid from date, valid to date, and
a list of bundles within that set. The ID of the bundle set and the ID of the bundles must be unique,
must be numeric and must be greater than or equal to 10000.

The bundle set is considered active, if the requested reporting date belongs to the date interval that
is defined in this set (the valid_from date to the valid_to date). You may have many active bundle
sets during the reporting period, and it is possible for the bundle sets to overlap. If there is more than
one active bundle set, then LRM uses the bundle set where the issue-date is the latest date.

Logical Expression for a User-defined Bundle

The logical expression for a user-defined bundle takes the form of two lists—the Include list and the
Exclude list. LRM reports a seat as using a license for a given bundle type, if at least one of the
license types in the Include list is used during the login session and none of the license types in the
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Exclude list is used during the login session. The bundle definitions can be represented as two linked
tables: Included Sellable Items and Excluded Sellable Items.

Included Sellable Items

Bundle
GUID

Bundle
name

SI-1
included

SI-2
included ... ... SI-40

included

Id-1 B1 0 1 ... ... 0
Id-2 ... ... ...
Id-3 Bn 1 1 ... ... 1

Excluded Sellable Items

Bundle
GUID

SI-1
excluded

SI-2
excluded ... ... SI-40

excluded

Id-1 0 1 ... ... 0
Id-2 ... ...
Id-3 1 1 ... ... 1

When a sellable item is included in a bundle, the corresponding field in the Included Sellable Items
table has the value of 1. If a sellable item is not included in a bundle, it has the value of 0. When a
sellable item is excluded from a bundle, the corresponding field in the Excluded Sellable Items table
has the value of 1. If a sellable item is not excluded, it has the value of 0. Note the difference
between a bundle being excluded and not included.

Logical Expression Example

Suppose you decided to define four bundles into the following:

• Bundle 1—Advanced Voice:
• Includes:

• Agent Desktop
• Outbound Contact
• Third-party work items

• Excludes:
• E-mail
• GVP Speech

• Bundle 2—E-mail:
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• Includes:
• E-mail

• Excludes:
• Outbound Contact
• Third-party work items
• GVP Speech
• Web Media

• Bundle 3—AutoContact:
• Includes:

• GVP Speech

• Excludes:
• Outbound Contact
• Third-party work items
• E-mail
• Web Media

• Bundle 4—Advanced Plus:
• Includes:

• Outbound Contact
• Third-party work items
• E-mail
• Web Media
• GVP Speech

The following linked sellable items tables show the contents of these four bundles and demonstrate
which sellable items are included and excluded:

Included Sellable Items

Bundle
name

Genesys
CIM

SIP
Server DesktopOutboundThird-

party
E-mail GVP Web

Advanced 0 0 1 1 1 0 0 0
E-mail 0 0 0 0 0 1 0 0
AutoContact0 0 0 0 0 0 1 0
Advanced
Plus 0 0 0 1 1 1 1 1
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Excluded Sellable Items

Bundle
name

Genesys
CIM

SIP
Server DesktopOutboundThird-

party
E-mail GVP Web

Advanced 0 0 0 0 0 1 1 1
E-mail 0 0 0 1 1 0 1 1
AutoContact0 0 0 1 1 1 0 1
Advanced
Plus 0 0 0 0 0 0 0 0

Calculating Seats

Bundle usage is calculated in the same way that concurrent sellable item usage is calculated.

To calculate the value of any user-defined bundle, the LRM shell script calculates all Genesys-sellable
items that make up that particular bundle. Then, LRM applies the bundle definition to comply with the
include and exclude rules.

For example, by using the E-mail user-defined bundle in the Logical Expression Example:

• For each one minute interval, LRM calculates the sellable item Genesys E-mail for every corrected seat.
• If the seat has a sellable item type of Genesys E-mail, LRM checks to confirm this seat does not have:

Genesys Outbound, third-party work items, GVP or Web items.
• If all conditions are true, the minute for this seat is stored for bundle calculation. If just one condition is

false, the value for this one minute is zero (0).
• This procedure is applied to all other seats for this minute interval and the total number of satisfied

seats for this minute is stored by LRM. This process continues for the entire reporting interval and the
maximum value with corresponding timestamps are stored as the value of the E-mail user-defined
bundle.

User-Defined Bundle File Format

User-Defined Bundle File Format

The Bundle File is an XML file that uses the following structure:
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<lrm_bundle_set>
The lrm_bundle_set element is the root element of the Bundle File.

Attributes

Attribute Required Description

issue_date Yes The issue date of the bundle set,
in YYYY-MM-DD format.

valid_from Yes The date this bundle set is valid
from, in YYYY-MM-DD format.

valid_to Yes The date this bundle set is valid
to, in YYYY-MM-DD format.

id Yes The unique ID of the bundle set.
Child Elements

Child element Occurrence Description

header Once The bundle set header
bundle One or more times The bundle element

<header>
The header element is the header of a bundle or bundle set.

Child Elements

Child element Occurrence Description

name Once The name of the bundle or
bundle set

description Once The description of the bundle or
bundle set

<bundle>
The bundle element is the bundle definition.
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Attributes

Attribute Required Description

id YES
The id of the bundle, must be a
unique number greater or equal
to 10000.

Child Elements

Child element Occurrence Description

header Once The bundle header
include_items Once The list of bundle included items

exclude_items Zero or more times The optional list of bundle
excluded items

<include_items>
The include_items element is the list of bundle include items.

Child Elements

Child element Occurrence Description

sellable_item One or more times The sellable items

<exclude_items>
The exclude_items element is the list of bundle exclude items.

Child Elements

Child element Occurrence Description

sellable_item One or more times The sellable items

<sellable_item>
The sellable_item element is the sellable item description, which is in the include_item or
exclude_item list.
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Attributes

Attribute Required Description

item YES The name of the Genesys-
sellable item.

license_type YES
The type of license. In this
release, only concurrent_seat
license type is supported.

Bundle File Example

Bundle File Example
<?xml version="1.0" encoding="utf-8" ?>
<lrm_bundle_set issue_date="2010-01-01" valid_from="2010-01-15" valid_to="2010-12-31"

id="5000" >
<header>

<name>Basic bundle set_1</name>
<description>General use bundles</description>

</header>
<bundle id="10001">

<header>
<name>A-Out Advanced Voice</name>
<description> Voice only</description>

</header>
<include_items>

<sellable_item item="genesys_inbound_voice" license_type="concurrent_seat"/>
<sellable_item item="sip_server" license_type="concurrent_seat"/>
<sellable_item item="genesys_network_voice" license_type="concurrent_seat"/>

</include_items>
<exclude_items>

<sellable_item item="genesys_email" license_type="concurrent_seat"/>
</exclude_items>
<exclude_items>

<sellable_item item="genesys_web_media" license_type="concurrent_seat"/>
</exclude_items>

</bundle>
<bundle id="10002">

<header>
<name>A-Out Advanced Voice</name>
<description> Voice only</description>

</header>
<include_items>

<sellable_item item="genesys_inbound_voice" license_type="concurrent_seat"/>
<sellable_item item="sip_server" license_type="concurrent_seat"/>
<sellable_item item="genesys_network_voice" license_type="concurrent_seat"/>

</include_items>
<exclude_items>

<sellable_item item="skills_based_routing" license_type="concurrent_seat"/>
</exclude_items>

</bundle>
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<bundle id="10003">
<header>

<name>A-Out Advanced Plus</name>
<description>Voice and e-mail</description>

</header>
<include_items>

<sellable_item item="genesys_inbound_voice" license_type="concurrent_seat"/>
<sellable_item item="sip_server" license_type="concurrent_seat"/>
<sellable_item item="genesys_network_voice" license_type="concurrent_seat"/>
<sellable_item item="skills_based_routing" license_type="concurrent_seat"/>
<sellable_item item="genesys_email" license_type="concurrent_seat"/>
<sellable_item item="genesys_web_media" license_type="concurrent_seat"/>
<sellable_item item="genesys_outbound_contact_ms" license_type="concurrent_seat"/>

</include_items>
</bundle>

</lrm_bundle_set>

Add a New Bundle Set

Add a New Bundle Set

1. To add a new bundle set to your system, you must first create a new bundle file.
• The lrm_bundle_set ID and bundle ID must be unique.
• The valid_from date should not be earlier than the date you choose to import your bundle.

2. Browse to the destination location of your LRM application.
3. To upload the new bundle file using GAX, go to Configuration > License Usage Reporting >

Bundles and click Upload.

The information from the bundle file is imported into the Configuration Server and the new user-
defined bundle is added to your system where it is now included in calculations and reports.

Deactivate a Bundle Set

Deactivate a Bundle Set

If you no longer require the use of a bundle set, you can stop the calculation of the bundle set by
changing the valid_to date.

1. Change the date of the lrm_bundle_set in the Bundle File to yesterday’s date (in UTC time zone).
2. To upload the new bundle file using GAX, go to Configuration > License Usage Reporting >

Bundles and click Upload.
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Even though you have changed the valid_to date in the Bundle File to yesterday’s date, the report
calculation for yesterday’s date (in UTC time zone) is not affected because the bundle is still active
for yesterday’s date.

The information from the Bundle File is imported into the Configuration Server and deactivates the
Bundle in your system. From this point forward it is no longer included in calculations and reports.

Change an Existing Bundle Set

Change an Existing Bundle Set

To change an existing bundle set, deactivate the old bundle set and then create a new one.

1. Deactivate the bundle set from a specific date.
2. Create a new bundle set and confirm you set the valid_to date of the newly created bundle is set to

the day after the deactivation date in the previous step.
3. Change both of the IDs of the bundle sets and the IDs of all the bundles within those sets.
4. To upload the new bundle file using GAX, go to Configuration > License Usage Reporting >

Bundles and click Upload.

Previous definitions of the bundles should be kept in the LRM database and Configuration Server in
case you need run reports for past dates. The bundle definitions are required to create the report
files.

The information from the Bundle File is imported into the Configuration Server and the changed user-
defined bundle is updated in your system. From this point, the bundle set is updated with your
changes for calculations and reports.
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Start LRM
When the installation of License Reporting Manager (LRM) has been verified, and the LRM databases
have been initialized, start LRM in Genesys Administrator.

1. In Genesys Administrator, select Operations > Applications > <LRM Application>.
2. Right click on the LRM application name and select Start applications.
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Stop LRM
Use Genesys Administrator to stop LRM.

1. In Genesys Administrator, select Operations > Applications > <LRM Application>.
2. Right click on the LRM application name and select Start applications.
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LRM Configuration Options

LRM Application object

LRM Application object

You can set the following configuration options in the [lrm] section on the Options tab of each LRM
Application object.

agentgroup_enabled
Default Value: false
Valid Values: true or false
Changes Take Effect: After restart
Specifies whether the LRM Server collects statistics and reports for agent groups.

binding.address
Default Value: ::
Valid Values: String representing an IP address.
Changes Take Effect: After restart
Specifies the address to which the HTTP/HTTPS listening socket binds to receive requests.

The default value :: binds to all IPv4 and IPv6 addresses. If your system does not have IPv6
configured, then you must set it to another valid value. You can set it to either one of the addresses
for this server or 0.0.0.0 to bind to all available IPv4 addresses on this server.

data-retention-days
Default Value: 400
Valid Values: Integer
Changes Take Effect: After restart
Specifies the number of days that LRM keeps data in the database.

first_time_data_calculation_max_days
Default Value: 2
Valid Values: Integer
Changes Take Effect: After restart
Specifies the maximum number of days the nightly scheduled job will calculate ICON and GVP data
for the first time LRM runs the statistics job.

lrm-excluded-time-1, lrm-excluded-time-2, lrm-excluded-time-3 (Optional)
Default Value: None
Valid Values: HH:MM:SS (hours, minutes, seconds); Duration (Seconds. The maximum value is 600)
For example:18:00:00;600
Changes Take Effect: After restart
Specifies the time interval (start time and duration in seconds) for which LRM does not calculate
concurrent seats.
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Warning
• If you do not use one or more of these options, remove them from the Options tab of

the LRM Application object.
• If you use the option without specifying a value, or with a value in the incorrect format

(for example, an empty string), LRM does not work properly and cannot calculate
concurrent seats.

lrm-network-switch
Default Value: false
Valid Values: false or true
Changes Take Effect: After restart
Specifies the presence of the network switch under LRM.

lrm-retention-days
Default Value: 400
Valid Values: positive integer
Changes Take Effect: After restart
Specifies the number of days LRM data is kept in the database.

nightly_data_calculation_max_days
Default Value: 7
Valid Values: Integer
Changes Take Effect: After restart
Specifies the maximum number of days the nightly scheduled job will calculate ICON and GVP data
for, if LRM missed calculating data for some days.

placegroup_enabled
Default Value: false
Valid Values: true or false
Changes Take Effect: After restart
Specifies whether the LRM Server should collect statistics and reports for place groups.

schedule
Default Value: 01:00
Valid Values: HH:MM[:SS]
Changes Take Effect: After restart
Specifies the time of day when LRM executes the statistics gathering job.

schedule-retry-delay
Default Value: 30
Valid Values: Integer
Changes Take Effect: After restart
Specifies the delay in minutes after the previous statistics job has failed before it tries to run the job
again.

schedule-retry-max
Default Value: 0
Valid Values: Integer
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Changes Take Effect: After restart
Specifies the number of times LRM should attempt to retry the nightly statistics gathering job if it
fails.

DAP Application object

DAP Application object

You can set the following configuration option in the [lrm] section on the Options tab of the DAP
Application object.

role
Default Value: main
Valid Values: main or icon
Changes Take Effect: Immediately
Specifies the role of the DAP. The LRM DAP value should be set to main and the ICON DAP value
should be set to icon.

GAX Application object

GAX Application object

You can set the following configuration options in the [lrm] section on the Options tab of the GAX
Application object.

agentgroup_enabled
Default Value: false
Valid Values: true or false
Changes Take Effect: Immediately
Specifies whether Agent group usage reporting is enabled.

license_type
Default Value: concurrent
Valid Values: concurrent or enabled
Changes Take Effect: Immediately
Specifies either enabled or concurrent as the license type. When set to enabled, only enabled seat
information is shown. When concurrent, both the enabled and concurrent seat information are shown.
By default, LRM reports using concurrent seats.

operation_type
Default Value: compliance
Valid Values: compliance or hosted
Changes take Effect: Next user login.
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Specifies whether LRM operates in either hosted mode or compliance mode. When operating in
hosted mode, all LRM features are available. When operating in compliance mode, the following
features are not available: reports for tenants, and provisioned count configuration.

placegroup_enabled
Default Value: false
Valid Values: true or false
Changes Take Effect: Immediately
Specifies whether Place Group usage reporting is enabled.
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Change History
This section lists topics that are new or that have changed significantly since the 8.1.x release of this
content.

New in Release 8.5.0

• The Deployment Guide and User's Guide were merged and restructured for usability.
• The installation prequisites were updated to include a tip about the inter-dependency between LRM and

Management Framework.
• Added requirement for GVP Reporting Server to About LRM and Deploying LRM (step 20).
• The Entitlement Information and Components and Functions were updated in About LRM.
• Platform Support was updated in Deploying LRM.
• The agentgroup_enabled, binding.address, first_time_data_calculation_max_days, and lrm-

retention-days configuration options were added to the LRM Application object in LRM Configuration
Options.
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